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1 Document Goal

The goal of this document is to provide you with an introduction on using Spagic platform by designing, deploying and

monitoring a sample process after the Spagic installation and configuration.

2 Versions History

Version/Release n° : 1.0 Date 29/06/2007

Description First release (English version)

Version/Release n° : 11 Date 03/08/2007

Description Added the steps for the creation of the backup database.

Version/Release n° : 1.2 Date 03/10/2007

Description Changed the configuration steps for datasources: from the release 1.0.1 they are
JNDI based.

Section 5.4: added the instructions about the taxonomyVisible attribute.

Section 5.4; added the instructions for installing the JDBC driver in Tomcat.

Section 5.1: changed the user for the backup database.

Version/Release n° : 2.0 Date 21/01/2008
Description Updated to Spagic 2.0.0.

Version/Release n° : 2.1 Date 29/07/2008
Description Updated to Spagic 2.2.0.

Version/Release n° : 2.2 Date 10/10/2008
Description Update some sections relative to freebXML
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3 Introduction

Spagic is a solution composed by a set of visual tools and back-end applications oriented towards design, realization,

deploy and monitoring of ESB infrastructures adherent to the SOA paradigm:
B Spagic Studio : Eclipse environment that consents the use of a single interface in order to create components
and processes managing the entire development cycle: design, service registry configuration (UDDI & ebXML),

metadata management, WSDL generation, rules definition, mapping, data integration (Talend Open Studio

generated job), custom services and orchestration.

B Enterprise Monitoring : for the monitoring, through Ajax interface, of the system information (system
monitoring), services & processes (services monitoring).

B Spagic Service Manager: using the open source ESB ServiceMix project and the Spagic listener it is possible
to manage correlated processes and information during the services orchestration. New binding components
have been implemented in synchronous modality also.

The platform supports also execution of BPEL processes through the open source Apache ODE BPEL engine.

B Persistence layer - MetaDB : the different services and the rules of process and extraction of the relevant
information are described and classified through a metadata system. Therefore the repository manages the
entire life cycle of the components and traces their use in order to optimize the monitoring activities. The

registration is made through Spagic studio and at runtime on Service Manager by means the specific listener.

The document was organized in the following way: there is a first section related to the Spagic complete installation (in
order: MetaDB, ServiceMix, Spagic Studio and Spagic Console), then there are the sections related to design, deploy,
run and monitor of a very simple process.

For more details about Spagic Studio environment see the document Spagic Studio User Guide.doc.

For more details about Spagic Console, see the document Spagic Studio User Guide.doc.
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4 Requirements

Required Tools URL for download/Notes Spagic Spagic Console
Studio
Database MySQL ) )
Required Required
Oracle
Eclipse Europa for Java EE http://www.eclipse.org/downloads/moreinfo/jee.php Required
equire
Developers a
GraphViz http://www.graphviz.org/ Required
juDDI http://ws.apache.org/juddi/ Optional Optional
freebXML http://ebxmlrr.sourceforge.net/ Optional Optional
JDK 1.5.0_11 or later http://java.sun.com/ Required Required
Apache Tomcat 5.5.17 http://tomcat.apache.org Required
Mozilla Firefox 2.0.0.x http://www.mozilla.com Required

5 Installation

The following steps allow you to install the entire Spagic platform.
In this document we will use the notation {SERVICEMIX_VERSION} for referring to the ServiceMix release used.

Current ServiceMix release is 3.2.1.

5.1 Persistence layer — MetaDB

To setup the metadatabase follow these steps:

1. Install MySQL Server (release 5.0 or higher) or Oracle (release 9i or 10g) or PostgreSQL (release 8.1)

2. Create a new schema “spagic” and a user “spagic” with password “spagic” and the permissions for writing into the
schema.
Generate the tables using the “spagic-metadb-<database type>.ddl” released in the spagic-metadb package.
Launch the scripts “setup-<database type>.sql” released in the spagic-metadb package, to load all the configuration
tables.

5. Optional step : install the backup database for monitoring data, if you want to clean periodically the monitoring data.
Create a new schema “spagic-bck” and assign to the user “spagic” the permissions for writing into the schema.

6. Generate the tables using the “spagic-bck-<database type>.ddI” released in the spagic-metadb package.
If you installed the MySQL Server and the processes's messages contain the attachments bigger than 1 MB, you

have to configure the variable max_allowed_packet = 16M into the file: {MySQL Server path}/my.ini and restart the

server.
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5.2 Service Manager

To install the Service Manager follow these steps:

1. To install ServiceMix, copy the folder “apache-servicemix-{SERVICEMIX_VERSION}’, released in the spagic-
service-manager package, into your Spagic installation folder (you should create this new folder). All base
components are already installed (component  http, tcp, jms...) into  “apache-servicemix-
{SERVICEMIX_VERSION}hotdeploy”. The monitoring system, composed by a listener, monitoring all the
exchanges handled by ServiceMix, and a process, listening for the queue populated by the listener, is already
installed and configured.

2. If you installed the database on a different machin e from the ServiceMix machine then configure the “apache-
servicemix-{SERVICEMIX_VERSION}conf\jndi.xml” file so that the datasource “java:comp/env/jdbc/metadb” links to
the database just created.

3. If you installed an Oracle database instead of MySQL then configure the “apache-servicemix-
{SERVICEMIX_VERSION}conf\hibernate.cfg.xml” file so that the property “hibernate.dialect " has the value
“org.hibernate.dialect.OracleDialect”.

4., To launch ServiceMix, launch the command “bin\servicemix from the apache-servicemix-
{SERVICEMIX_VERSIONY}" folder.

5.3 Spagic Studio

To install Spagic Studio on client machine follow these steps:

1. Get graphviz installation package from http://www.graphviz.org/ and install it. If you're using windows, simply run

graphviz executable file and follow the wizards. During the installation steps take in mind the location where the

executable dot program was installed.

In Windows (ltalian language) default installation graphviz will install the dot program in
C:\Programmi\ATT\Graphviz\bin\dot.exe

2. Spagic Studio is distributed as an Eclipse application, so you have simply to get it from Spagic distribution (from the
package spagic-studio) and unzip it.
In this document we will refer to the Eclipse folder as SPAGIC_STUDIO_HOME.
If you want to create Spagic Studio from scratch, instead of using the distribution package, please refer to the

document “How to cook your Spagic Studio”.

3. Spagic Studio needs to connect to Spagic metadabase. Ensure that the database is running and that permissions

are configured properly on database server.

4. Optional step : an installation of Tomcat with JUDDI installed, if you want to publish your services in UDDI
Registries. To install JUDDI refer to its installation documentation. After the installation, it needs to create manually
in the “publisher” table a new publisher with “publisherld” set to “eng”, the same value configured in the Service
Registries List Wizard on Spagic Studio (for detail see the document “Spagic Studio User Guide”, section “Manage

Process Publication on Service Registries”).
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5. Optional step : an installation of Tomcat with freebXML installed, if you want to publish your services in ebXML
Registries. To install freebXML refer to its installation documentation

(http://ebxmlrr.sourceforge.net/wiki/index.php/Install)

After the installation you should execute the following steps:
1. launch the omar web application (http://localhost:8080/omar);

2. create a new user account following the instructions visualized on the web page (use alias: eng, password:

engeng);

3. import the key (*.p12) generated to your Web browser following the instructions visualized on the web
page;

4. import the key (*.p12) into the keystore located in the <OMAR_HOME>/ jaxr-ebxml/security directory, using
the omar GUI application in the following way. Open the command line, run the command build
run.browser, select the Registry Location and click the following button:

= Registry Browser Java Ul

File View Help
- ..
& g L

Registry Location: hitn//localho stEOE0Omatregistryysoap

AT
Nicrmman: |

The Registry Browser Java Gui will display the following window:

= Key Registration Wizard
Digital Certificate Information

Keystore Alias: Private Key Password:
[eng [

File to Import existing Certificate from:

| Choose File to import from ...

| OK I Cancel |

The “Keystore Alias” field has the value “eng”, the same value configured in the Service Registries List

|C:IProgrammi‘tomangenerated-key—eng.m2

Wizard on Spagic Studio (for detail see the document “Spagic Studio User Guide”, section “Manage
Process Publication on Service Registries”). The “Private Key Password” field has the value “engeng” (the

same configured on Spagic Studio), the “File to Import” contains the path of the file *.p12 just generated.
Note: the keystore password is “ebxmlrr”.

5. Copy the keystore containing the key with alias eng, from the <OMAR_HOME>/ jaxr-ebxml/security
directory to keystore directory located into the “org.spagic.ui” plugin in SPAGIC_STUDIO_HOME/plugins

To start you only need to launch eclipse.exe in SPAGIC_STUDIO_HOME.
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5.4 Spagic Console

To install Spagic Console follow the next steps:

1. Install the Apache Tomcat 5.5.17; to install it refer to its installation documentation (http://tomcat.apache.org).

2. Install the database JDBC driver for the database you are using in the Tomcat common\lib folder:
« If you are using MySQL, please use mysql-connector-java-5.0.7-bin.jar or later.
¢ If you are using Oracle 9i/10g use the JDBC driver for JDK 1.4 and Oracle 10g (it works also on 9i). The driver

name is ojdbc14 jar.

You can retrieve both the drivers from the lib folder of the ServiceMix released in Spagic.

3. Install the web application SpagicConsole: you should copy into apache-tomcat-5.5.17\webapps folder the
Spagic.war released with Spagic.

@ 4. If you used a configuration different from the defa ult suggested in this document , before starting Tomcat it 's

necessary to verify the following Spagic Console configuration files and update them:

« If you installed the Console on a different machine from the ServiceMix machine

a) Update the file \SpagicConsole\WEB-INF\conf\imx\servers.xml to set the jmxUrl to the URL for connecting
to ServiceMix by JMX. The URL is written by ServiceMix on its console, on the startup.

b) Update the file \SpagicConsole\WEB-INF\conficonsole\console.xml to set the locationRestartWs,
locationBackupWS and locationDeleteWS parameters to the URL where you installed ServiceMix. These
are the URLSs of the restart, backup and clean database operations.

« If you installed the database on a different machin e from the Tomcat machine , update the file
\SpagicConsole\META-INF\context.xml so it could link to the Spagic database (with the JNDI name
jdbc/spagic).

¢ If you installed an Oracle database instead of MySQL then configure the “\SpagicConsole\WEB-
INF\classes\hibernate.cfg.xml” file so that the property “hibernate.dialect ” has the value
“org.hibernate.dialect.OracleDialect”.

e If you used UDDI :

a) Update the file \SpagicConsole\WEB-INF\classes\Serviceregistry.properties to set the URL of jUDDI
application.

b) Configure the “\SpagicConsole\WEB-INF\conficonsole\console.xml” file so that the attribute
“taxonomyVisible” has the value “TRUE” and the attribute “serviceAttribute" has the value “uddi”

e If you used ebXML :

a) Update the file \SpagicConsole\WEB-INF\classes\ jaxr-ebxml.properties to set the URL of freebXML
application (jaxr-ebxm.soap.url property)

b) Configure the “\SpagicConsole\WEB-INF\conficonsole\console.xml” file so that the attribute

“taxonomyVisible” has the value “TRUE” and the attribute “serviceAttribute" has the value “ebXML”
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6 Developing a Process

Spagic Studio is an Eclipse environment that allows the use of a single interface in order to create components and
processes managing the entire development cycle. For the details, see the documents Spagic Studio User Guide and
Spagic JBI Components.doc.

In this section we’ll shortly describe all steps for developing the processes using a simple example.

6.1 Create a Spagic project

Open Spagic Studio and create a workspace for working, for example call it SpagicDemo.

As first step, configure the Spagic Studio Preferences from Window->Preferences->Spagic Preference, set the attributes
for the MetaDB, the graphviz application, select the service registry.

To create a new project, select File->New->Project->Spagic 2.0->Spagic 2.0 Project, insert a Project Name, StartSpagic,
click Finish.

In the workspace, the project just created has a standard structure containing the followings directories:
« Bpel: contains all BPEL files and artifacts generated when using BPEL technology;
« Deployables: contains the following files produced by Spagic Studio:
O <Process name>_v_<version>-sa.zip : service assembly to be deployed in ServiceMix.

O <Process name>_v_<version>.deploy : deploy file necessary to publish the process on the Spagic
MetaDB, if you don’'t want to use Spagic Studio but a Spagic command line tool (necessary for example
when migrating the processes from test environments to production environments).

O <Process name>_v_<version>.properties : optional file created if within the processes are used some

configurable parameters.

« Integration Process: contains all Spagic file describing the service assembly in terms of endpoints and flow

between them;
« Mappings : contains resources used by the mapping component. Almost of this resources will be XSLT file.

e Scripts : contains resources that are used by Scripting Components. At the moment groovy is the language for

the scripting so this folder will contain groovy file;
¢« SemanticRules : contains resources used by Semantic Validator Component;
«  SyntaxRules :contains resources that are used by the Syntax Validator Component;

« WsdlIFiles : contains resources automatically generated by Spagic Studio if the process contains entry endpoint

relative to HTTP Component configured to be a SOAP Provider.

6.2 Design the process

To define a new process, select the Integration Process folder, open the context menu and New->Other->Bpmn
Diagram. Insert a file name, for example firstProcess.

When the file has been created in the Integration Process folder, the visual Spagic editor will be opened.
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To design a very simple process, select, from the component palette located at the right of the editor, an Empty Start
element and put it to the editing area. Then put an element Empty End on the same process, and link the start element

with the end element.

Double click on the pool hame and change it to “firstProcess”; assign also a name to the start element (“start”) and to the

end element (“end”).
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The result should be similar to the following screenshot.
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Before proceeding you have to add 2 views to the Editor: choose the command Window->Show View->Other and select

the views Intermediate Model and Observable Attributes.

Window Help

e WWindow
Mews Editor
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Preferences. .. =1 Snippets
) Tasks
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Now you are ready to choose the technology that Spagic will use to generate the process: remember that Spagic 2 now
supports more technologies (JBI and BPEL), and it's in the next step that you select the proper technology for your
process.

According to the technology that you’ll choose you have to follow different paragraphs:
=  For JBI read [6.2.1] JBI Technology

= For BPEL read [ 6.2.2-6.2.3 ] BPEL Technology, Complete with further technical definitions

6.2.1 JBI Technology

Select the pool firstProcess (it should be unique) and in the view Properties select the Tab Technology: here you should
found a combo containing the supported technologies.
Choose “JBI — Apache ServiceMix” and select Bind to Runtime: now your process has the JBI technology associated,

and you are ready to use the services provided by this specific technology.
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In the next steps you have to specify which specific technological services are bound to the steps of your BPMN

diagram.
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To do this, select the view IntermediateModel: you should see the list of all services available for JBI.

Open the StartService category and drag the service JBI-HTTPInputBindingComponent on the step start.
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Spagic Getting Started

Spagic Studio asks if you want to associate this BPMN step with the JBI service (also called Binding) JBI-
HTTPInputBindingComponent that is an HTTP Binding Component configured as In-Only.

¢ L~ ()

¥ attach Service[StartService] with Binding (JBI-HT TPInputBindingComponent) on on Empty Skart Event stark |

start end L= Intermediar,,. #
s
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You are ready to configure the HTTP BC of the first step.
Select the start step and configure all the properties in the Properties tab, in the item IM-Model.
In the firstProcess sample you need simply to insert the value http://0.0.0.0:8195/firstprocess in the property Uri.
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Configure also the final process’ step with the binding EndService->JBI-ConsoleOutputBindingComponent.
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Spagic Getting Started

The process is completed: the BPMN diagram was annotated with all the technological information needed to perform

deploy and monitoring.

To perform these activities you need to execute an intermediate step that consists of generating an Eclipse model (called

Intermediate Model) that allows in future using the Spagic features also with editors different from the BPMN editor.

Select the BPMN file (not the diagram, the file that ends with .bpmn) and after right click on it, choose BPMN For
Intermediate Model->Export BPMN To Intermediate Model.

B L/j IntegrationProcess ‘ ‘

3
-] firstPre =
Jpen F3 4’0
Cpen With r "
= SemanticRy efid
(= SyrtaxRule = Copy Chri+C
(= wsdFiles | [ Faste hrf-4
¥ Delete Delete
Mave. ..
Rename Fz
2 Impart...
&7 Expoart...
2 | Refresh F5
rVers EE outline | £ IntermediateModel £3
Validate P
riceMix
1] Mark as Landmark Ctrl+Ale+5hift+Up "
iz
2k Remove from Conbesxt CErH-AlE+-Shift+-Dowin
Initialize bpmn_diagram diagram file
Run &5 ¥ IhdingComponent
Debug As ¥ IngCompanent
Profile &s » |gCompaonent
Team » pComponent
Compare With 4
Replace With 4
Source L4
BPMM Faor Intermediate Model 4 Iter Configuration

Wersion Bprn Diagram

FHEEEs Alt+Enter Expart BPMM To Inkermediate Model

firs

You should see a new file called firstProcess.im: this is the file necessary for deploy and publication on meta-db.

Every time you change the BPMN diagram, you must rege  nerate the Intermediate Model.

6.2.2 BPEL Technology

Modify the previous process adding a new step. Select, from the component palette located at the right of the editor, a
Task element and put it to the editing area; assign it the name “assign”. Link the start element with the task element and

the task element with the end element.
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& Java EE - StartSpagic/IntegrationProcess/firstProcess. bpmn_diagram - Eclipse Platform
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Select the pool firstProcess (it should be unique) and in the view Properties select the Tab Technology: here you should

found a combo containing the supported technologies.

Choose “BPEL Runtime” and select Bind to Runtime: now your process has the BPEL technology associated, and you

are ready to use the services provided by this specific technology.
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In the next steps you have to specify which specific technological services are bound to the steps of your BPMN

diagram.
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/ * Spago towards SOA integration */

To do this, select the view IntermediateModel: you should see the list of all services available for BPEL.

Open the StartService category and drag the service BPEL-Receive on the step start.

& Java EE - StariSpagic/integrationProcess/irstProcess. bpmn_diagram - Eclipse Platform
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Spagic Studio asks if you want to associate this BPMN step with the BPEL service (also called Binding) BPEL-Receive

that is a receive activity.

o
F'.ttan:h Se

vice[StartService] with Binding (EPEL-Receive) o

=St #

To display all the properties, select the start step, then the Properties tab, in the item IM-Model.

All properties have been configured.

Configure the assign step with the binding TaskService->BPEL —Assign.
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& Java EE - StartSpagic/IntegrationProcess/firstProcess.bpmn_diagram - Eclipse Platform
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You have to configure the assign step: select it and configure all the properties in the Pro

RERCHE 05

perties tab, in the item IM-

Model. Set the property assignmentType with value Variables, the property from(Variable) with value input, the property

to with value output.
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Configure also the final process’ step with the binding EndService->BPEL-Reply.
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The last step has been configured.
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The process is partially completed: the BPMN diagram was annotated with some technological information needed to

perform deploy and monitoring.

To perform these activities you need to execute an intermediate step that consists of generating an Eclipse model (called

Intermediate Model) that allows in future using the Spagic features also with editors different from the BPMN editor.

Select the BPMN file (not the diagram, the file that ends with .bpmn) and after right click on it, choose BPMN For
Intermediate Model->Export BPMN To Intermediate Model.
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You should see a new file called firstProcess.im: this is the file necessary for deploy and publication on meta-db.

Every time you change the BPMN diagram, you must rege

6.2.3 Complete with further technical definitions

nerate the Intermediate Model.

The BPEL process is partially completed: the BPMN diagram was annotated with all the technological information

needed to perform monitoring but we have to add further technical definitions. For this purpose, we preferred to use a

specific designer: BPEL Designer.

In the editor area, select the .im file, open the context menu and select Intermediate Model->Generate BPEL Model.

Into the folder Bpel, the new folder firstProcess was generated, containing the files firstProcess.bpel and

firstProcess.wsdl
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& Java EE - StartSpagic/IntegrationProcess/firstProcess. bp

mn_diagram - Eclipse Platform

File Edit Diagram Mavigate Search Project Run Window Help
s F-0-Q- i gH IGis g (% (5 ) Datssourcenction | @ aom ML oRe & 5 & dava |5 Javatr |
=3 Ea'}év:.g-‘-‘:;vﬁ- =
L7 Project Explorsr 53 = O [ firstProcess.bprin_diagram 52 = 0| 3= cutine 52 =0
| & v A|| Palette * =
. ~
= Startspagic =
== Select | O_,l_'—_\_Q
(= = FirstProcess [EE.. #| | £
2 firstProcess.bpel @ e Il
X irstPracess.wsdl 2 assign i
= IntsgrationProcess £ o e
[ FrstProcess.im E start - end cv
=
o fstProcess. bprn =
] firstProcess. bpmn_diagr I =
= Mappings Q
= Scripts g e
(= SemanticRules b ff;p_y
[ SyntaxRulss v
= WadlFils | [
£ | ¥ e
[2 Problem: | Tasks | = Properties &2 4L servers | B Data Source Explorer | 3 Snippets | T IntermediateMadel | =1 Observable attributes| = O
1 1 1 —
Bpel - StartSpagic
| Aﬂ.vam:ed Property ‘Value
= Info
derived false
editable true
last modified 26 gennaio 2008 11:08:37
linked False
location C:iprogetti|SpagiciSpagicDemol StartSpagicBpel
name: Bpel
path iStartSpagic/Bpel
£ | 5 & 3|

To complete the bpel process execute the following steps:
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[ FirstProcess.wsdl input
(= InkegrationFrocess ®] start CDUEpE - = Tnitislizevariable
- FirstProcess,im . (@ Correlation Sets & % Lo assign
|=| FirstProcess.bpmn = InitializeWariable @) end
-1 Firstprocess.bpmn_diagt %
. .
(= Mappings =
[ Seripts %
- [ SemanticRules =
- [= syntaxRules ] end
= wedFiles »
o
L] | 3|
|2 Problems Tasks | =l Properties £3 o Servers 1 Data Source Explorer | [ Snippets | ™ IntermediateModel| T Observable attrbutes| = O |
= InitlalizeVariable
il
Description =i
Details N | Fiseed value v| e |variable -
G | <sesdifirstProcessResponse xminsixsd="urn:eng: spag - @ input : firstProcessRequestMessage
Documentation xsdiresultf> B Y
e AR £ @ output ; FirstProcessResponseMessage
< | ¥ Hew Query: |
o '

Select the InitializeVariable activity and then the tab Properties : specify the payload for the output variable;
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& Java EE - StartSpagic/BpelifirstProcess/firstProcess. bpel - Eclipse Platform

File Edit Mawigate Search Project Rum Window Help

il -0 Q- iEE & B Datasource Action @ o P omg o B & Java | @ Javake |
; ; 5 ! S
[ Project Explorer 52 7 0| [] firstProcess.bpmn_disgram | 2 FrstProcess 50 = O 5E outine 52 =
BEE|e T el & firstPracess
= & StartSpagic ) B Partner Links & 3 || ®-ED Partner Links

= (= Bpel [+ @ Variables

i client
R 5l " :
= firstProcess B et % @ Correlation Sets
+ |5 FirstProcess, bpelesx: = [= = main
2 FirstProcess,bpel Il e @] start
¥ firstPracess wsdl @] start » _output 3 InitializeVariable
1= IntegrationProcess i i (@& Correlation Sets % % -~ assign
[ FrstProcess.im = Tnitialzevarisble | -] end
e firstProcess.bpmn = A 1Ll
[ i =
[ firstProcess. bpmn_diagr = i
(= Mappings e %
[ Scripts —
Glend | = | ! | 22|

1= SemanticRules - - e - || = - |
= SyntaxRules 21 Problems | | Properties &% 4k Serversjﬁ Data Source Explorer | 251 Snippets | 1 IntermediateModel | T Observable attributes| = 01|

= wsdFiles I =

= InitializeYariable

| [ validate

| Description

| Details T From: | Fixed Value v To: Wariable v

| Jaoin Behavio
Sl ) xsdfirstProcessResponse «mins:xsd="urn:eng;spagic
Documentation <zsd:resulti >

<jxsdifirstProcessResponse s

input : FirstProcessRequestMessage
tput ¢ firstProcessResponseMessage

Mew Query: ‘

[[] 1gnore Missing Source Data [[Ixesp Source Element Mame

2.

File Edit Mavigate Search Project Run  Window Help
gitse B © (™ 5 4 Datasource Action aoa Th bRg Lo £ 8 3ava |92 tavakE |
:f[j Project Explorer 23 = O || [} firstProcess.bprn_diagram :Qf\rstProcess b = O 5F outdire 22
BE|le T £ main A 3 4 firstProcess
= StartSpagic T FiesPartner Links & %
(= Bpel = e client [#- @ Variables
T =
(== FirstProcess B start %‘ @ Variables e - Correlation Sets
+ =] firstProcess.bpelex y B
2 FirstPracess.bpel = InitializeVariable ‘l input
[ FirstProcess.wsdl output
5 ] ] i
=== IntegrationProcess = assian (& Correlation Sets &%
i (& firstProcess.im s T =
2] FirstProcess,bpmn = >
| end
-] firstProcess, bpmn_diagt # 2
(= Mappings =
.= scripts ! @ < - | 3|
i -[= semanticRules | - - . =1 — - == . =S|
(= syntaxRules | Problems | = Tasks | | Properties 23 i Servers | 8 Data Source Explorer | 1 Srippets | T IntermedisteMadel | T Observable Attributes | =a
(= wisdlFiles | . - =l 1 —
= assign
| Description | Ovaidate
Details |variable: v Ter |ariable ~
Juin Behavior — " " "
= @ input ; firstProcessRequestMessage input ; FirstProcessRequestMessage
| e L En 17 payload : FirstProcesskequest & output ; firstProcessResponseMessage
# @ output : firstProcessResponseMessage
Query, ‘ Query, ‘
£ | 3 D Ignore Missing Source Data D Keep Source Element MName
e
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6.3 Publish the process

After designing the process, you have to publish it: this step will save the process information (properties, flow...) into the
MetaDB.

In the editor area, select the .im file, open the context menu and select Intermediate Model->Publish to MetaDB.

— .

Mew 4

Cpen With 4

il = Copy Chrl+C
= [ Paste Chrl+Y
3 Delete Dielete
Move...
R.ename Fz

2 Impart...
7 Expart...

4k Servers EE outling | = Intermed

ache ServiceMix

# | Refresh FS

Yalidate
o] Mark as Landmark Chrl+-Al+Shift+Up
= Remove from Conbext Chrl+-Al+5hift+Daown

Run As

Debug As

Profile As

Tearm

Compare With

Replace 'with

Source

Intermediate Model

ne ServiceMix

LtputEindingComponent
putBindingComponent
utBindingComponent
LitBindingCaompanent

bl * Y T v v v ¥

Publish to MetaDE

aenerate WaDL For Service Mix
Generate Service Mix Application
“Process.im - StartSpagic/IntegrationProcess Generate BPEL Model

Properties Ale+Enter

If you have some errors, verify that you installed graphviz tool and you created the temporary directory that should be
configured in the Spago Preferences, in the item Graphviz temp folder.

Spoa St Freference Letault Urganization | Engineering |
Team Graphviz dot program Location | C: fProgrammifATT fGraphviz binfdot |
Validation -
Graphviz temp folder C:ftm
Web and XML S s Ll
Web Services SM¥ GetResources Service http:/localhost: 9092 jgetResources)
xDoclet
= e [Rest:ure Qefaults] [ Apply ]
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6.4 Deploy the process

To deploy the process implemented with JBI technology , in the editor area, open the context menu after selecting the
.im file and select Intermediate Model->Generate Service Mix Application. The firstprocess_v_0-sa.zip will be created in
the project Deployables folder.

SuurLe " hodified
Intermediate Model Publish to MetaDB
Generate WDL For Service Mix

Properties Alt+Enker

Fl.pp"l:.

tProcess.im - Start3pagic/InteqgrationProcess Cameraiz BFIEL g

The label _v_0 is assigned to the process because it's now possible to specify the process version: you have not

specified this information, so the default version (0) is assigned.

To deploy the process implemented with BPEL technology , in the editor area, open the context menu after selecting the

.bpel file and select Deploy->Deploy in Service Mix.

& Java EE - StartSpagic/Bpel/firstProcess/firstProcess. bpel - Eclipse Platform

File Edit MNavigate Search Project Run  ‘Window Help
i F-D- Q- EBE Fis i E @S 4 i Dstasowceacion | @ ik o e b 7 & 1ava |:.°3 Java € |
i 0 f=
[ Praject Explorer 52 = O || [d] FirstProcess.bpmn_diagram 2 FirstProcess 02 = 8| B2 outine 52 25 |
) 2
== g ~| 2 firstProcess = |E‘B =
| B 1= tartspagic ] e Partner Links & % Partner Links
(= Bpel e & client @ Variables
b el u _
(= firstProcess £ PETE— &% T @ Correlation Sets
|5 firstProcess, bpelex | » el =) main
<l | = InitislizeVariable input + Q, stark
; [0 FirstProcess.we  Mew 4 output = Initialize¥ariable
(== IntegrationProcess (& Correlation Sets % % -5 assign
™ Open F3 =
<t FirstProcess.im - R 2 end
=| firstProcess.bpmn | i
-] firstProcess.bpmn &2 copy e
[ Mappings = . Il
= Seripts 5
1= SemanticRules M Delete Peiete: * = -
= SyntaxRules Mave... T Servers % Data Source Explorer | 2 Snippets | T IntermediateModel | T Observable Attributes | =
= wisdIFiles Rename F2 =
£25 Impart...
= firstProcess
7y Expart....
¥ Value
& | Refresh F5
Validate fekie
oI Mark as Landmark ChrbAlE+SHiFt+ e
kel ancmar; T Bl 28 gennaio 2008 11:40:16
= Remave from Context  CerH-Alt+Shife+Down False
Run As L§ iZihprogettiySpagicl SpagicCema)\Start SpagiciBpelifirstProcessifirstProcess, bpel
Debug As » firstProcess.bpel
Praofile As » [StartSpagic/BpelffirstProcess|firstProcess.bpel
Team v 1975 bytes
Compare With L3
Replace With r
; L3
Source L3 .
15 | |
j{- .32 Fretprocessib Propetties Alt+Enter

‘istart B & &

A pop-up window will be displayed, insert the process uri: http://localhost:8214/firstProcess and then click the Ok button.
The firstprocess-sa.zip will be created in the BPEL folder.
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Start ServiceMix launching the command bin\servicemix.bat (or .sh) from apache-servicemix-{SERVICEMIX_VERSION}.
After ServiceMix was started, copy the .zip generated in the hotdeploy folder and verify in the ServiceMix console that

the process was deployed without errors.

INFO - ComponentMBeanImpl — Starting component: transformerForSupplier
INFO - JBIContainewr — Activating component for: [container=ServiceMix.name=supplierScreenQutput] wit
service: {http://servicemix.orgscheeselsupplierScreenfutput component: org.apache.sepvicemix.components.util.Streamtlri
lerComponent@3f 79885

— GComponentMBeanImpl

— GComponentMBeanImpl
AutoDeploymentS8ervice
AutoDeploymentService
ServicefissemblyLifeCycle
ServicelnitLifeCycle
ServicellnitLifeCycle
SevvicellnitLifeCycle
Jetty
Jetty
— 8ServicellnitLifeCycle

Initializing component: supplierScreenfutput
Starting component: supplierScreenfutput
Directory: deplo Finished installation of archive: storedar
Directory: deplo Archive changed: processing transformerdJar
Starting service assenbly: transformer
Initializing serwice unit: transformerhttp-su
Initializing ruice unit: transformerlu L
Starting service wunit: transformerhttp—su
1

lectChannelConnector @ localhost:8194
Starting service unit: transformerl:

— JBIContainer Activating component for: [containe erviceMix . name=nyTransformertransformer]
rith service: {http://servicenix.org-/cheese*myTransformertransformer component: org.apache.servicemix.components.xslt.¥
1tComponentBE2d465a

Fi

— ComponentMBeanImpl i lizing component: mylransformertransformer
— ComponentMBeanImpl ng component: nylransformertransformer
— JBIContainer — Activating component for: [container=ServiceMix.name=myScreenfutputtransforner|
with service: {http:-sservicemix.orgscheesermyScreenQutputtransformer component: org.apache.servicemix.conponents.util]
StreanmlriterComponentB128hf £
INFO — ComponentMBeanImpl — Initializing component: myScreenfutputtransformer
Starting component: myScreenOutputtransforner
Directory: depls Finished installation of archive: transformerdJa:
Directory: deploy: Archive changed: processing firstprocessJar.zip
Starting service assembhly: firstprocess
Initializing sewrvice unit: fi processhttp—su
Initializing service uwnit: firstprocesslu—su
Starting service unit: firstprocesshttp—su
Jetty—6.
Started SelectChannelConnectnr B localhost:8195
— SewrvicellnitLifeCycle Starting sewrvice unit: firstprocesslu—su
— JBIContainer Activating component for: [contain erviceMix.name=ScreenQutputfirstprocess]
with service: {http:/szervicenix.orgscheezeXScreenOutputfirstprocess component: owrg.apache._servicemix.components._util. g
reamlriterComponentBe?62ec
IMNFO — ComponentMBeanImpl — Initializing component: Screenfutputfirstprocess
INFO — ComponentMBeanImpl — Btarting componen ScreenQutputfirstprocess
INFO - AutoDeploymentService — Directory: deploy: Finished installation of archive: firstprocessdJar.zip

— ComponentMBeanImpl

— AutoDeploymentS8ervice
AutoDeploymentService
SevrviceAszemhlyLifeCycle
SevrvicelnitLifeCycle
ServicelnitLifeCucle
ServicelnitLifeCycle
Jetty
Jetty

7 Run the Process

To run the process you can use a simple HTML page that invokes, with an AJAX call, the Web Service defined in the
firstprocess process.

You can find this page in the distribution, in the package spagic-service-manager, within the folder “sample-clients”.

Use the page client.html to launch the JBI process or the page clientBpel.html to launch the BPEL process.

Open the HTML page with Mozilla and click the button sendSOAP to start a new process execution.
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8 Monitor the Process

Spagic Console is a web application to monitor, through Ajax interface, the system information (system monitoring), the
services, and the processes (services monitoring).

It's recommended to use the Firefox Mozilla 2.0.0.x

For more details about Spagic Console please read the document Spagic Studio User Guide.doc.

Start the Tomcat where you installed the Spagic Console.

8.1 Authentication

The URL to launch the Spagic Console is: http://localhost:8080/Spagic/.

The first page visualized by the web application is the authentication page.

Insert the user spagic and the password spagic and then click the button >

B spagic Console - Mozilla Firefox =lal x|

Ble  Modfica  wisusleza Cronologia  Segnalbri  Strumentl 2

- @ (% [ heepiinecamostianantspagics [l ] [z o0 129

W Spagic

. User Name ,—
e — »

Passivord

Completato

The next page contains the application menu.

Spacgéc

do ogm 2 of
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8.2 Process List

Select the icon Process List (Iflqlfl) to view all processes and theirs configuration, properties, and static flow diagram. The

list contains the following attributes:

Name: process name.
Type: process technology.
Valide From: start validity date.

Valide To: end validity date.

YV V V V V

Instance: number of process instances.

> = :displays the process detail containing the description, version, organization, service name.

Y

ﬁqﬁ: displays the process graph.

The process list should contain only firstProcess: the process just deployed and launched.

) spagic Console - Mozilla Firefox =18 x|

Fle Modfica Wisualizza  Cronologia  Segnalbri  Strumenti 7

LR = l’g“ ﬁ | [ http:flacalhost:6080/Spagic/serviet/AdapterHTTPPACTION _NAME=PracessListFikeredAction = B G| secoe iG]

Ll Spagic Console

¥ Spagic

T A Process List EE]

Taxonomy | fter
ALl pracesses |
B3 Business

[} Administrative Services

W@
Hame: Type Valide From Valide To Instance
firstPracess & 22/01/08 o a8 Al

) Financial Services
] Integration Services

Completato

You can perform a search by Taxonomy (if you choosed to install jUDDI or freebXML) or by Iter using the section in the
left side of the page.
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8.2.1 Process Graph

Selecting the icon an from the process list, it's possible to display the process graph.

Selecting the elements on the graph it's possible to display a window containing Name, step Description, Service and its

Properties.

2)Spagic Console - Mozilla Firefox

Fle Modfica Wisualizza  Cronologia  Segnalbri  Strumenti 7

&b @

’L’Lt‘ |@ http:f flocalhost: B080/Spagic/Processaraphaction. action?processId=1 | > ‘ > ‘ @'iGougle

|| Spagic Console

¥ Spaoic

& & Al

Process firstProcess

[CHI®]

[WE

Mamespace Iurn:eng:spagic:processes:ﬁrstProcess:vD

Hame Iﬁrsthcess‘starti\Lﬂ

Description | Description for start

Properties
uri [http:si0.0.0.0:8195 rstprosess
SoapVersion |1.2

imservicename [tartssruics

Soaphction |

Flaglssaap [erus

im.servicesntity IServlceGEnenc

FlaglsssEnabled [raise

im servicebndinzname [161-HTTPInputSindingComponent

Completato
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8.3 Process Instances List

Selecting the icon Process Instances List (tn'i) the process instances list is showed. The list contains:
» Id: identifier of process instance.

Process: process name.

Iter: name of the iter (optional) associated to the process instance.

Instance: attributes identifying the iter instance (optional).

Start: start execution time.

End: end execution time.

YV V V VYV V V

State: instance state. It can be active (yellow V), executed (green ) or fault (red X).

> a : visualizes the process execution detail.

) spagic Console - Mozilla Firefox =18 x|

Fle Modfica Wisualizza  Cronologia  Segnalbri  Strumenti 7

@ S * (g‘ ﬁ | httpejflocalhost: 8080/Spagic/serviet/AdapterHTTP?ACTION _NAME=ProcessInstancelistFiteredaction :'i EP‘ @-iduuc_ﬂe || |

|| Spagic Consale ] Test firstProcess

= |
_‘ [#] spagic Console 3 | LI ServiceMix SOAP Binding Example i -

¥ Spag

& & ) g A4 Process Instances List @ 2 2 5 @

‘ Tavoromy | er DG

&L All processes

B B Id Process Iter Instance Start End State
-7 Business !

1 firstProcess 23701708 10.22 23501708 10,22 v _ ;I

Completato

It's possible to perform a search by Taxonomy or by Iter using the section in the left side of the page.
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8.3.1 Process Instance Graph

Selecting the an icon from the process instances list it's possible to display the graph representing the execution of the
process.

The color of the component represents the component state: the green color means executed, the yellow color means
active and the red means error.

Selecting the elements on the graph it's possible to visualize the window containing Detail and Relevant Data.

The Relevant Data tab contains the messages having as destination the component selected. Selecting the XML link in

the list, the XML message will be visualized; in this case Request and Acknowledge.

) spagic Console - Mozilla Firefox =18 x|

Fle Modfica Wisualizza  Cronologia  Segnalbri  Strumenti 7

@ i [ (Q‘ ﬁ | httpej flocalhost: 8080/Spagic/ProcessGraphAckion, action?processInstanceld=1&processId=1 :‘i EP‘ @-iduuc_ﬂe | |

|| Spagic Consale ] Test firstProcess

_‘ [Z] spagic Consale (3 | | ServiceMix SOAP Binding Example i -
i ] Spacgic
Z & of d F Instance 1 of Process firstProcess B @ @
. . |
— Detail [ Relevant Data [
Eoat) 0 state start ssazge Data

4 1 Acknowledge 10,22

Request | Ackrowlsdze |

<?xml version="1.0" -
encoding="UTF-8"?><ACTIONS
xmlns:env="http://schemas.xmlsoap.org/ soap/

itertype="Registrazione Nido"s <ACTION
class="it.eng.spagobi.services.actions.3ess
neme="SESSION EXPIRED_ACTICH™
scope="REQUEST"> <CONFIG/>  </ACTICN>
<LCTION
class="it.eng.spago.dispatching.action.ucil
idpratica="254" name="START ACTICON"
scope="REQUEST">  <CONFIG/> </ACTION:>
<LCTION
class="it.eng.spagobi.services.actions.Port
neme="LOGIN ACTION SBEI SETTINGSZ"
5c|opa="REQUEST"> <c0NFIG/>I </ RCTION> _'Ll
4 »

Completato
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8.3.2 Advanced Search

Selecting the icon Advanced Search (—%) in the Process Instances List, at the top of the page, the Advanced Search
page is displayed.
The page contains:
» Process: process name.
Version: process version.
Type: process technology.
Organization: process organization if the process was published on a service registry (jUUDI or freebXML).
From and To: start and end validity process dates.
State: it can be Executing, Error, Executed.

Order by: order criteria.

vV V. V V V V V

Iter type

) spagic Console - Mozilla Firefox

o =

Fle Modfica Wisualizza  Cronologia  Segnalbri  Strumenti 7

@ - b @‘ ﬁ | http:fflocalhost: G080/ Spagic/ProcessSearchaction. action ‘LP‘ L—l | Google :7_|
|| Spagic Consale ] Test firstProcess
| [&] spagic Console @ | [ servicemix S0P Binding Example -
rj% o O Q E Advanced Search @ @
Pracess ffirstProcess v | Version [0 Type [ JB) 'I

Grganization vI

From [ S @

State 'l Order by | Date 2 IDESC i

|ter Tupe | A Processes -

Search

Completato

9 Related documents

The publications listed in this section are considered particularly suitable for a more detailed discussion of the topics
covered in this document.
1. Spagic JBI Components.doc: detail document about ServiceMix and Spagic JBI components.

2. Spagic Console.doc: detail document about Spagic Console monitoring application.
3. Spagic Studio User Guide.doc: detail document about Spagic Studio environment.
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